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COURSE:  

Computer Applications 2
UNIT 9: 

Presentations
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Annotation: 
This unit includes lessons on how to use presentation software to create effective presentations for use in industry.  Students will learn how to use all aspects of presentation software and also the skills involved with making a presentation effective and with the actual presenting such as public speaking skills.  They will also learn how to put a presentation onto the internet.

Grade(s):  
	X
	9th

	X
	10th

	X
	11th

	X
	12th


Time:  
10  hours
Author: 
Dawn Squires
Students with Disabilities:

For students with disabilities, the instructor should refer to the student's IEP to be sure that the accommodations specified are being provided. Having a copy of the students’ testing accommodations effectively informs the teacher of needed changes for students with disabilities effectively informs the teacher of needed changes for all tests.  Instructors should also familiarize themselves with the provisions of Behavior Intervention Plans that may be part of a student's IEP. Frequent consultation with a student's special education instructor will be beneficial in providing appropriate differentiation.
Reducing, shortening, or modifying assignments due to disability issues will be determined on a case by case basis.  Individual assistance opportunities will be provided as needed.   

Individual assistance opportunities provided as needed.  Students will learn to develop and plan independent of note skill techniques.  Students are required to be creative and descriptive in problem-solving skills.

All learners will be provided the strategies to maximize their learning potential.  Students who are gifted in areas will be challenged to stretch their thought processes.  Students with disabilities will be challenged and assisted to develop and expand skills as well.

Students will be provided guided practice, independent practice and peer support.  Order of problem resolution skills:  Refer to text, utilize Help button, ask a neighbor, ask the instructor.  When administering peer tutoring, do not touch your neighbor’s mouse.
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GPS Focus Standards: 
BCS-CA2-5
Students will use presentation software to create, edit, and publish industry appropriate files. 
a)
Use views appropriately to create and manipulate presentations. 

b)
Analyze situations and create a customized handout. 

c)
Create a presentation with video, embedded objects, specialized features, e.g. action buttons, links, hyperlinks, record narration, on-line broadcast. 

d)
Import relevant data from word processing, spreadsheet, database, and presentation files.


e)
Create a summary slide. 

f)
Create a stand-alone version of a presentation. 

g)
Create, modify, and design templates including master slide, master title slide, master notes, and header/footer. 

h)
Utilize grids and guides in the placement of objects. 

i)
Demonstrate presentation skills and proper public speaking techniques by creating well-organized, audience-appropriate presentations such as informative, entertaining, and instructional. 

j)
Demonstrate an understanding of how to put a presentation on the web. 

GPS Academic Standards:
ELA11LSV2 
The student formulates reasoned judgments about written and oral communication in various media genres. The student delivers focused, coherent, and polished presentations that convey a clear and distinct perspective, demonstrate solid reasoning, and combine traditional rhetorical strategies of narration, exposition, persuasion, and description. 

National / Local Standards / Industry / ISTE:
Communication I 
Communicate in a clear, concise, correct, and courteous manner on personal and professional levels.
Communication II
Societal Communication – Apply basic social communication skills in personal and professional situations.

Communication III
Workplace Communication – Incorporate appropriate leadership and supervision techniques, customer service strategies, and personal ethics standards to communicate effectively with various business constituencies.

Communication IV
Technological Communication – Use technology to enhance the effectiveness of communication.
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Enduring Understandings: 
•
Using views to create/manipulate presentations.
•
Incorporates videos, embedded objects, specialized features (action buttons, links, hyperlinks, narration, etc.)
•
How to incorporate relevant data from Word, Excel, Access, and other PowerPoint files.

•
Proper use of master slides and master handout slides.

•
How to present various types of presentations:  instructional, informative, entertaining.

•
Know how to put a presentation on the web.

•
How can an Action Button help manipulate a linear PowerPoint?

•
How can grids and guides be utilized in placement of shapes in a PowerPoint presentation?

•
How can one insert links and hyperlinks into a presentation?

•
How does one create a stand-alone version of a presentation, and what is it used for?
•
How can one collaborate with PowerPoint 2007?  

Essential Questions: 
•
How are industry appropriate presentations created using PowerPoint? 


•
How can information from other applications be utilized in PowerPoint presentations?

•
What is the difference between linking and embedding information in PowerPoint presentations?

•
How does one import/link data from a database to PowerPoint?
Knowledge from this Unit:  
Students should be able to:
•
Describe verbal and nonverbal communication skills
Skills from this Unit:  
Students should be able to:
•
Analyze situations/audiences
•
Analyze situations for appropriate presentations/handouts.
•
Create presentations with videos, embedded objects, specialized features, e.g., action buttons, links, hyperlinks, record narration, on-line broadcast.
•
Make effective PowerPoint presentations.
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Assessment Method Type: 

	x
	Pre-test

	x
	Objective assessment - multiple-choice, true- false, etc.

	
	_x_ Quizzes/Tests

_x_ Unit test

	
	Group project

	x
	Individual project

	x
	Self-assessment - May include practice quizzes, games, simulations, checklists, etc.

	
	_x_ Self-check rubrics   

__ Self-check during writing/planning process

__ Journal reflections on concepts, personal experiences and impact on one’s life

__ Reflect on evaluations of work from teachers, business partners, and competition judges

__ Academic prompts

__ Practice quizzes/tests

	
	Subjective assessment/Informal observations

	
	__ Essay tests

__ Observe students working with partners

__ Observe students role playing

	x
	Peer-assessment  

	
	_x_ Peer editing & commentary of products/projects/presentations using rubrics

__ Peer editing and/or critiquing

	x
	Dialogue and Discussion

	
	__ Student/teacher conferences
__ Partner and small group discussions

_x_ Whole group discussions
__ Interaction with/feedback from community members/speakers and business partners

	x
	Constructed Responses

	
	__ Chart good reading/writing/listening/speaking habits

__ Application of skills to real-life situations/scenarios

	x
	Post-test


Assessment Attachments and / or Directions: 
Presentations Exam 
Presentations Pre-Test 
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Instructional planning: 
•
LESSON 1:  DESIGNING AUDIENCE-APPROPRIATE, WELL-ORGANIZED PRESENTAIONS - 1

1.
Identify the standards. Standards should be posted in the classroom.
BCS-CA2-5
Students will use presentation software to create, edit, and publish industry appropriate files. 
a)
Use views appropriately to create and manipulate presentations. 

b)
Analyze situations and create a customized handout. 

c)
Create a presentation with video, embedded objects, specialized features, e.g. action buttons, links, hyperlinks, record narration, on-line broadcast. 

d)
Import relevant data from word processing, spreadsheet, database, and presentation files.


e)
Create a summary slide. 

f)
Create a stand-alone version of a presentation. 

g)
Create, modify, and design templates including master slide, master title slide, master notes, and header/footer. 

h)
Utilize grids and guides in the placement of objects. 

i)
Demonstrate presentation skills and proper public speaking techniques by creating well-organized, audience-appropriate presentations such as informative, entertaining, and instructional. 

j)
Demonstrate an understanding of how to put a presentation on the web. 

2.
Review Essential Question(s). Post Essential Questions in the classroom. 



•
How are creative, custom presentations designed and demonstrated?
3.
Identify and review the unit vocabulary. Terms may be posted on word wall.

	Stand-alone presentation
	Package for CD
	Embedded object

	Linked object
	Action button
	Summary slide

	Master slide
	Master notes
	Slide sorter view

	Normal view
	
	


4.
Interest approach – Mental set
Begin this lesson by having students complete the pre-test either on paper or through Exam View, attachments Presentations Pre-Test.

5.
Give each student a copy of the handout All About Me.  This is an assignment where students create their own PowerPoints.  
6.     Have students use the provided rubric to assess their own PowerPoints, Powerpoint Rubric
7.
Have students reflect about PowerPoint presentations they have made.  Discuss and identify characteristics that makes effective/ineffective presentations; boring/engaging presentations.  These characteristics can be written on the board.
•
LESSON 2:  DESIGNING AUDIENCE-APPROPRIATE, WELL-ORGANIZED PRESENTATIONS - 2

1.
Identify the standards. Standards should be posted in the classroom.

BCS-CA2-5
Students will use presentation software to create, edit, and publish industry appropriate files. 
a)
Use views appropriately to create and manipulate presentations. 

b)
Analyze situations and create a customized handout. 

c)
Create a presentation with video, embedded objects, specialized features, e.g. action buttons, links, hyperlinks, record narration, on-line broadcast. 

d)
Import relevant data from word processing, spreadsheet, database, and presentation files.


e)
Create a summary slide. 

f)
Create a stand-alone version of a presentation. 

g)
Create, modify, and design templates including master slide, master title slide, master notes, and header/footer. 

h)
Utilize grids and guides in the placement of objects. 

i)
Demonstrate presentation skills and proper public speaking techniques by creating well-organized, audience-appropriate presentations such as informative, entertaining, and instructional. 

j)
Demonstrate an understanding of how to put a presentation on the web. 

2.
Review Essential Question(s). Post Essential Questions in the classroom. 



•
How are creative, custom presentations designed and demonstrated?

3.
Review from the previous lesson some aspects of effective PowerPoints.

6.
Show students the PowerPoint How to Plan a PowerPoint Presentation.  This PowerPoint reviews the initial steps in creating a successful/effective presentation.

7.
Then share with students the PowerPoint Creating Effective Presentations.  This PowerPoint is from the Foundations Skills 5-2 and gives students rules of thumb for creating effective presentations.
8.
Following this, launch into tips to effectively speaking in public.  These are tips provided as a resource by Toastmasters International which are very good.  Explain to students what Toastmasters International is.  See PowerPoint: 10 Tips for Public Speaking.

9.
Show students about the non-verbal communication skill of gesturing during presentations.  These tips were also taken from the Toastmasters International website under their free resources:  Gesturing Tips. 
10.
Lastly, have students present their All About Me presentations from the day before utilizing the Public Speaking Tips and Gesturing Tips.
•
LESSON 3:  LINKING AND EMBEDDING CHARTS/DATA FROM EXCEL INTO POWERPOINT

1.
Review Essential Questions. Post Essential Questions in the classroom. 


•
How can information from other applications be utilized in PowerPoint presentations?

•
What is the difference between linking and embedding information in PowerPoint presentations?

2.
Share with students that oftentimes information contained in Excel spreadsheets, databases, Word, etc., can be included in PowerPoint presentations.   Embedding (the same as importing) or linking prevents from having to input the data in two different applications.  There are two ways that this data can be included:  one is by embedding the data (importing).  The other is by linking to the data.  
3. 
Share the PowerPoint Linking or Importing with the students.  The PowerPoint includes an activity for students to see the difference between linking and embedding data.
4.
Demonstrate to students the method of linking to a chart in an Excel spreadsheet that is on a worksheet by itself.  Point out to students that the active worksheet when the Excel file is saved is the worksheet that will be linked.  Use the Excel Workbook Student Body Demographics for the chart to link to.  Have students save the PowerPoint presentation with the title Student Body Demographics also.  Change the number of students that are white from 500 to 1500.  Students should save the PowerPoint, paying particular attention to the active worksheet when they save it.  Close and open the Student Body Demographics PowerPoint presentation file, and update the information. 
5.
If students did not have the Chart as the active sheet, have them reopen it and save the file again with the chart as the active worksheet, reopen the PowerPoint Student Body Demographics file and update the link.

6.  
Also point out to students that when they change the number of white students in the student body to 1,500 that the percentage also changes.  Review with students how to calculate percentage of one number as it pertains to another number.  Also, have students create proportions to show how the percentage changes when the numbers change.
7.
For practice, have students create an Excel spreadsheet containing data that interests them.  Examples are sports trivia, school demographics, budget, etc.  Once the students have created the data, have them create a chart that contains the data and save the Excel workbook.  Have the students create an embedded and a linked PowerPoint presentation – Name the PowerPoint with the embedded data, Embedded practice-First&LastName; and the one with linked data LinkedPractice-First&LastName.  Direct students to change one of the categories of data or add another category to the existing data in the Excel workbook.  Save the workbook and reopen the PowerPoint files, paying particular attention to which file updates the data and which doesn’t.  Print, as you wish, for summary or teacher observation as a means of assessment.
8.
Also, demonstrate to students how to copy and paste the chart into the PowerPoint presentation using the Paste Special option.  Have the students elect to link the data when using the Paste Special option also.  Remind them this is another option for linking and embedding data.

9.
Demonstrate to students how to link a Word document into a PowerPoint presentation.  Students will use the file Linking-Embedding Word Table.


This activity requires the following files:




•
Military Data



•
Military Data Table

10.
As a means of eliciting questions, use the mud puddle technique – Students write the topics that were as clear as mud (not clear) on a Post-it note and stick it on a poster on the way out of the door.  
•
LESSON 3:  IMPORTING DATA FROM ACCESS

1.
Review Essential Questions. Post Essential Questions in the classroom. 



•
How does one import/link data from a database to PowerPoint?
2.
PowerPoint 2007 does not provide for linking directly to Access.  In order to make this happen, while in the database, the table, report, query, etc., will need to be exported to either Word, text, or a spreadsheet.  Any of these three types of files can be linked to PowerPoint slides by importing, embedding or linking.
3.
Demonstration:  Open the file Newest Nursing Home.  Open the InserviceClasses Query.  Select the query by clicking the Select All button.  See image:
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4.
After selecting the entire query, click the External Data tab.  In the Export grouping, select Word.  Note the name given to the document and the location – you can change these.  

5.  
The Word document can then be opened, the table selected, copied, and pasted using the Paste Special option into PowerPoint.  

6.
The data from the database cannot be linked to Word, and thus cannot be linked to the PowerPoint.

7.
You may use these techniques for tables, reports, etc.

•
LESSON 4:  INSERTING ACTION BUTTONS INTO POWERPOINT 

1.
Review Essential Questions. Post Essential Questions in the classroom. 

•
How can an Action Button help manipulate a linear PowerPoint?
•
How can grids and guides be utilized in placement of shapes in a PowerPoint presentation?

•
How can one insert links and hyperlinks into a presentation?

2. 
Ask students to recall a time they viewed a PowerPoint which had buttons they had to click that carried them to another slide, a previous slide, etc.  Identify these as action buttons.  
2a.
Have students play a math Jeopardy game that utilizes Action Buttons – Geometry2.
3. 
Guide students through steps of creating action buttons by following the steps in this on-line tutorial:  http://www.internet4classrooms.com/pp_buttons_show_07.htm. 
4.  
Demonstrate to students how to turn on the grids in a PowerPoint presentation.

5.
Demonstrate how to make shapes snap to the grids on the page.

6.
Inserting links and hyperlinks:

a) Demonstrate inserting links to another slide in the presentation.

a. Open the Gesturing Tips PowerPoint presentation.

b. On the last slide Type a new bulleted item:  To First Slide.

c. Highlight the text and click insert hyperlink.

d. In the Insert Hyperlink Dialog Box, select Place In This Document.  Note available options with students.  Choose First Slide.

e. In presentation show, when this text is clicked, it will take you to the first slide in the PowerPoint presentation.  Save the file as:  Linked Gestures.
b) Demonstrate inserting hyperlinks to resources on the web, other files, etc.

a. Demonstrate inserting a hyperlink to a website – your school’s website; a Word document, or an Excel file – Any other file will do.

7.
Means of formative assessment:  Teacher observation/questioning and Mud Puddle.
LESSON 5:  RECORDING NARRATION IN POWERPOINT

1.
Review essential question:  

•
How can voice narration enhance presentations?
2.
Explain when narration in a PowerPoint presentation can be most helpful.

a.
When the presentation will be viewed via the web.

b.
For viewing later.  It would have comments made by the presenter, so the viewer would have access to most of the same materials presented at the actual presentation.

c.
If presentation is going to be a self-running presentation.


d.
Discuss how you want to time yourself for the presentation.

e.
To incorporate math, give the students scenarios of presentations that have 3, 5, 10, 20 slides and the different times that the presentation must be completed by.  Let them calculate how much time there is for narration on each slide.

3.
Must have a microphone, sound card, and speakers for this to work.  Tip:  If you do not have a microphone, simply plug the headset into the microphone jack and speak into the ear piece.

4.
Comments can be inserted through voice narration in lieu of a full narration of the PowerPoint presentation.

5.
A speaker icon will appear in the PowerPoint once narration has been completed.
6.
Recall that narration takes precedence over other sound effects that may have been included in the presentation.

7.
During the recording process, PowerPoint records the amount of time that you actually spend on each slide.  These settings can be saved or discarded or turned off.

8.
One other note about narration:  the narration can be linked to the PowerPoint or embedded in the PowerPoint.   Embedded, makes the files very large, but there is not a chance of forgetting to take the sound files with you if you use the presentation on another computer.  Linked narration means that the narration is not included in the PowerPoint presentation file.  It is contained in a separate file.  If the presentation is made using a computer other than the one it was prepared on, you must remember to also copy the narration file and include it in the same folder as the PowerPoint presentation file.

9.
Consider having notes.  Notes along with the narration benefit a viewer who is deaf or hard of hearing, and even those whose computers don’t accommodate sound.

a.
Savings the Presentation as a webpage will allow the notes to be visible during the presentation of each slide.  If you are saving the file as a presentation, print out the notes for those people, if it will benefit your presentation. 

10.
Demonstrate to students how to record narration.  
a.
Choose any PowerPoint presentation you would like to record the narration for the students.

b.
After selecting the slide that you want to begin the narration on, click on the Slide Show Tab; click Record Narration button.

c.
The Record Narration dialog box pops up.  You may click the Set Microphone Level to set the microphone’s level or the Change Quality button, to select a different quality of recording.  It is also in this dialog box that you would click the Link narrations dialog box if you do not want the narration to be saved in the presentation itself.  You would select the Browse button to select where to save the narration for the presentation.  If this choice is left blank, the narration will be embedded into the presentation.

d.
Click the OK button in the Record Narration dialog box and begin recording.  Point out to the students that the screen looks like an actual presentation.  Once completed with the narration for that particular slide, click the slide to advance to the next slide in the slide show.  Continue with the narration.  When the end of the slide show is reached, a dialog box will open that gives you the opportunity to save the slide timings as well.  Saving the slide timings will automatically advance the slides.  You can choose not to save the timings and inject your own.

e.
If after saving the slide timings, you want to disable them.  Simple delete the speaker buttons from the slides and remove the check from the Use Rehearsed Timings Box on the Slide Show tab.

f.
Play the timings from the beginning.

g.
For practice, have students open the gestures PowerPoint and narrate the slides.  Allow them to play them back, modify them, etc.  
h.
Observe the students during this practice.

i.
For a means of assessment, have students narrate their All About Me presentations, allow them to per assess each other’s work, make corrections and submit for grading.  

LESSON 6:  INSERTING VIDEO INTO POWERPOINT

1.
Review and post essential question:  How do videos enhance PowerPoint, and how do I incorporate videos into PowerPoint presentations?
2.
Videos can be incorporated into PowerPoint presentations one of two ways:
a.
By having the video file located on the same computer as the PowerPoint file; and

b.
By having the video hyperlinked to an Internet site.

3.
For videos that are located on the same computer as the PowerPoint presentation:
a.
Videos must be in one of these file formats:  .asf; .avi; .mpg or .mpeg; or .wmv.

i.
Cannot include movies or clips of movies from a dvd.

ii.
Click on the Insert tab, under Media Clips grouping select Movie.  Navigate to the location of the movie file, and insert it. 

b.
To play You Tube videos without Internet:

i.
Go to MediaConverter.org.

ii.
With this site, enter the URL for the video and follow the directions.

iii.
Tip:  The videos must be high resolution.  If not, they will appear very grainy or pixilated.

iv.
Remind students that videos on You Tube are copyright protected.
4.
For videos contained on You Tube, follow these steps to play the video on the PowerPoint slide:
a.
In PowerPoint, you must have the Developer tab enabled.  If it is not, click the Office button, and select PowerPoint Options.  Under the Popular options, select Show Developer tab in the Ribbon and click OK.

b.
On the Internet, select You Tube video that you wish to include to play directly on the PowerPoint.  I’ve chosen Phishing:  At Home

c.
We need to modify the url of the video by removing “watch?” and by replacing the “=” with a “/” – of course, don’t type the quotation marks.  After making these changes to the url, simply copy the url.

d.
Go to the PowerPoint presentation and the slide you want the video to show on.  I like to change the layout of the slide to Title Only. 

e. Select the Developer tab.

f. Click the More Controls button in the Controls grouping (Hammer and Wrench).  In the More Controls dialog box, select Shockwave Flash Object and press OK.  Draw a box where you would like for the video to show – size you want also.  

g. Select the Properties button in the Controls grouping.

h.
In the box adjacent to Movie, paste the copied URL.

i.
In the Loop option, change it to False, unless you want the video to continue playing over and over.

j.
Change the Playing option to False also.

k.
Close the Properties dialog box.
l.
In the PowerPoint, play the Slide Show.  The video should appear on the slide.  Note that you must have a live-feed (Internet connection) in order for this to work.

m.
If you do not have an Internet connection where the PowerPoint will be played, it is possible to download and save the You Tube videos to your computer.  

n.
Project:  Students should open the Military Data file and include the You Tube video found at: http://www.youtube.com/watch?v=g_w7VdePQHs  two different ways:  save the file by using the MediaConverter website, saving the video in an acceptable file format, and inserting the video clip into the presentation on a new slide.  Also, students should hyperlink to the video on the You Tube site, but have the video play on the slide itself.  As a means of assessment, the teacher will observe and check-off students on the two skills.
LESSON 7:  CREATING A STAND-ALONE VERSION OF A PRESENTATION

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How does one create a stand-alone version of a presentation, and what is it used for?

2.
A stand-alone presentation is one that can be carried on a flash drive, CD, etc., and played on another computer that may not have PowerPoint installed on it.

3.
 Explain that when presentations contain linked data, the data will not appear in the presentation if both of the files are not located in the same folder.  It is imperative that you make sure both the presentation file and linked file are copied and carried to a new computer to present the presentation.
4.
PowerPoint provides an easy method of completing this task.  It is called Package for CD.  Use the Embedded Homeruns presentation created in Lesson 2 to demonstrate this concept.
5.
To locate this function in PowerPoint, click on the Office button.

6.
Hover over Public, and select Package for CD.

7.
A message about what PowerPoint viewer will include is provided.  Click OK.

8.
A Package for CD dialog box opens.  It is in this dialog box that you can elect to send the presentation to a CD to be written to it, or you can choose to copy the information to a folder by pressing the Copy to Folder button.  Click Copy to Folder.  Another dialog box opens asking you to name the new Folder and put it wherever you would like.  Accept the Default location (just note where it is), and Name the Folder: SA-CD-FirstInitialLastName.  SA is for Stand Alone CD.  Note the number of characters that the folder name will accept is limited.  You may have to be creative.  
9.
Another “warning” is given asking you if you want to include linked files in your package.  Click Yes.

10.
The computer does its trick, and a folder is created with all of the needed files included.  Note that you can also add other files if you wish by clicking Add Files button.  

11.
Have the students navigate to where the package for CD file was sent.  Have them open the folder and view the contents.  They will note that the Excel file is included, along with PowerPoint viewer (in the event the computer that will be used does not have PowerPoint on it), and other files needed to run the presentation.

12.
This file can be copied to a disk or to a flash drive for transport to another computer.

13.
If narration is added to a file, a movie clip is included, etc., one would definitely want to package the presentation for CD if the presentation would be made on a computer other than the one the files were created on.  Note:  If hyperlinks to online videos, etc., are included, an Internet connection will still be necessary.

14.
Have students prepare the Military Data file for a stand-alone presentation (package for CD) after the video clips have been integrated into the presentation as described in Lesson 6.  Teacher observation and checking-off this skill can be used as the form of assessment.
LESSON 8:  CREATING MASTER SLIDES AND MASTER NOTES WITH HEADERS AND FOOTERS

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How does one utilize a master slide when preparing a Presentation?

2.
Explain to students that PowerPoint has several “master slides” that are prepackaged in the program.  We refer to them as layouts.  One can completely create a new “layout” or master slide or one can simply format, animate, add images, etc., to existing slide masters.  By using the slide master to add backgrounds, themes, colors, animations, it creates uniformity in a presentation.  It works best to create your presentation without adding styles, etc.  After the presentation is complete, then use the slide master to add these things.  Recall that uniformity is a characteristic desired by viewers.
3.
Open the presentation Quitman Nursing Home.  Note there is no formatting present.  Also make note of the layouts utilized in the presentation.
4.
Click the View tab and click the Slide Master button.

5.
Let’s add formatting and an image that will present our logo to the title slide and the other slide format that is used in the presentation.  Also, we will add animation to all of the slides using the slide master.
6.
Slide the Slide Master that is the layout of the title slide – Title Slide Layout (it’s the 2nd one from the top on mine.)  Let’s add a background to it first.  Select the Background Styles drop-down arrow, and choose Style 6 (It looks dependable and trustworthy.)  
7.
Let’s add an image to represent our nursing home.  Click the Insert tab and click Clip Art.  Let’s put in an image of a nurse.  Place the nurse just over the middle section of the footer and enlarge the nurse just a little.  Let’s also apply an animation to the title slide.  Click the Animations tab and choose the “Dissolve” transition.

8.
Let’s add the same background style, image, and transition to the Title and Content Layout master slide.  Let’s place the same nurse image in the upper right corner of the title on this layout.
9.
When completed, click on the Slide Master tab, and click Close Master View button.

10.
When attempting to select the correct Slide Master, hovering over the Slide Master layouts will reveal if the layout has been used on any slide and how many slides it was used on.

11.
Play the Slide Show.  Note that the logo stays the same on each slide.  Additionally, all backgrounds are the same (and they were only inserted on one slide), and finally the transitions are the same.

12.
For practice:  Using the Military Data PowerPoint created in an earlier lesson, add an appropriate logo to the slides, apply a background, and apply a transition to all slides using the Slide Master.

13.
As a means of assessment, check off the students on the three formatting events in the slide master.  See the file Quitman Nursing Home Solution.
LESSON 9:  CREATING A SUMMARY SLIDE

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How is a summary slide beneficial, and how is one created?

2.
A summary slide is often times referred to as a table of contents.  It is usually used at the beginning of the presentation and simply lists the key points that will be presented in the presentation.

3.
In PowerPoint 2007, the summary slide feature has been omitted.  To include a summary slide, simply insert a slide with the layout of your choosing.  For the bulleted points, simply copy and paste the titles from the slides that you wish to include onto the summary slide.

4.
For demonstration, we will use the Quitman Nursing Home presentation created in Lesson 8.

5.
At the end of the presentation, add a new slide.  Simply copy and paste the titles of Slides 2-5 as bulleted items on the last slide.  Instead of titling the slide Summary, I chose to type the company’s name again, Quitman Nursing Home.

6.
Use the slide sorter view, to move the slide to the first position right after the title slide.

7.
See files Quitman Nursing Home Summary (PPT) and Quitman Nursing Home Summery (MHT).
LESSON 10:  CREATING CUSTOMIZED HANDOUTS

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How can one create customized handouts for a presentation?

2.
Customized handouts can be exceptionally beneficial for the audience.  The customization helps improve the viewer’s perception of the presenter and the material/business presented to the audience.

3.
To create customized handouts, we will use the Nursing Home presentation from Lesson 9.  Open it.

4.
On the View tab, select Handout Master.

5.
In the Page Setup grouping, click the Slides Per Page drop-down arrow, select 2 slides.  In the placeholders grouping, keep the check marks in the Header, Date and Page Number.

6.
Highlight the title Quitman Nursing Home in the top left corner, change the font to Times New Roman, 14 pt.  Also, change the date to the same font and pt size.  

7.
Finally, in the Background Styles, select Style 6 and Close the Handout Master.

8.
Click the Office Button and go to Print.  In the print dialog box, Choose Handouts.  Under Slides Per Page, choose 2.  You may preview the slides or print them.

LESSON 11:  CREATING ON-LINE BROADCASTS

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How can one collaborate with PowerPoint 2007?  

2.
PowerPoint 2007 no longer has the On-line broadcast feature built into PowerPoint to make this happen.  It is present in PowerPoint 2003 and earlier versions.  In order to broadcast to participants in different locations, one would need to utilize Microsoft Office Life Meeting or another similar online service – Google Docs, etc., to collaborate online or share presentations. 

LESSON 12:  PUTTING A PRESENTATION ON THE WEB

1.
Review Essential Questions. Post Essential Questions in the classroom. 
•
How can one publish a presentation on the web?

2.
With the presentation open that you wish to publish to the Web, Click the Office Button and then select Save As.

3.
You may accept the default name or change it.   Change the file type to Single File Web Page.
4.
Click the Publish Button in the Save As dialog box.  A Publish as Web Page dialog box opens.  You can select which pages to publish or publish an entire presentation.  You can choose to show speaker notes.  Click the Browse button to navigate to the desired location.  Click the Publish button.

•
ATTACHMENTS FOR LESSON PLANS

· Presentations Pre-Test.rtf 

· All About Me.doc
· Powerpoint Rubric.doc

· How to Plan a PowerPoint Presentation.ppt

· Creating Effective Presentations.ppt

· 10 Tips for Public Speaking.ppt

· Gesturing Tips.ppt

· Linking or Importing.ppt

· Student Body Demographics.xls

· Linking-Embedding Word Table.doc

· Military Data.ppt

· Military Data Table.doc

· Newest Nursing Home.mht
· Geometry2.ppt
· Quitman Nursing Home.ppt

· Quitman Nursing Home Solution.ppt
· Quitman Nursing Home Summery.ppt

· Performance Assessment.doc

· Performance Assessment Rubric.doc

•
NOTES & REFLECTION: 
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Culminating Unit Performance Task Title: 
· Preparing Informational and Instructional Presentations
Culminating Unit Performance Task Description/Directions/Differentiated Instruction: 
· Students will prepare and present an informational and an instructional presentation.
Attachments for Culminating Performance Task: 
•
Performance Assessment Instructions
•
PowerPointRubric – Performance Assessment
•
PowerPointRubric
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Web Resources:
· Geometry2.ppt was retrieved from http://www.hardin.k12.ky.us/res_techn/countyjeopardygames.htm on 5/2/10.

Materials & Equipment: 
•
Computer and Microsoft Office 2007 Suite
21st Century Technology Used:  
	x
	Slide Show Software
	
	Graphing Software
	x
	Audio File(s)

	x
	Interactive Whiteboard
	
	Calculator
	x
	Graphic Organizer

	
	Student Response System
	
	Desktop Publishing 
	x
	Image File(s)

	
	Web Design Software
	
	Blog
	x
	Video

	
	Animation Software
	
	Wiki
	
	Electronic Game or Puzzle Maker

	
	Email
	x
	Website
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